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April 1997

This README contains installation procedures, feature highlights and other information to get 
you started using CompuServe 3.0.2.  If you have already installed CompuServe 3.0.2, please 
skip Minimum Requirements and Installation Notes, and continue with the sections that follow.
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1.  Upgrading to CompuServe 3.0.2

If you are running CompuServe 3.0 or CompuServe 3.0.1 without the latest Service Pack, we 
recommend you upgrade to CompuServe 3.0.2. CompuServe 3.0.2 incorporates the latest 
Service Pack, fixes several bugs, provides better Dial-Up Networking error messages, and offers 
new context-sensitive help that focuses on troubleshooting connection problems and includes 
Microsoft Internet Explorer 3.02 with several security fixes.

2. System Requirements

Windows 95 Windows NT 3.51 and NT 4.0

- 8 Mb RAM (16 recommended) - 16 Mb RAM
- 60 Mb free hard disk (to install)* - 60 Mb free hard disk (to install)*
- 28 Mb free hard disk (to run) - 28 Mb free hard disk (to run)
- 486 33 or better processor - 486 33 or better 
- VGA Monitor (640x480) - VGA Monitor (640x480)
- 9600 baud (or higher) connection rate - 9600 baud (or higher) connection rate

* If you encounter errors during installation, increasing the free hard disk space to 70 or 80 Mb 
may resolve them.

3. Installation Notes



CompuServe 3.0.2 can coexist with the CompuServe Information Manager for Windows 
(WinCIM) 2.0.1 and CompuServe 2.5 and will share common files (like CompuServe Mail's 
Address Book).  CompuServe 3.0.2 is installed in a separate folder and will not overwrite earlier 
versions of CompuServe software. 

It is recommended that you install CompuServe 3.0.2 in the same directory as your other 
CompuServe programs.  By doing so, CompuServe 3.0.2 will automatically have access to your 
current information, such as settings, Address Book listings, quotes, portfolio entries, your 
Favorite Places, and other information.

3.1 Installing CompuServe 3.0.2 for Windows 95 and NT 4.0:

1.  Insert CD-ROM in your drive.
2.  Click on Start Menu and choose Run.
3.  Type D:\RUN.EXE and then click OK. (Replace D: with your drive letter if different.)

Note:  If you have the Windows 95 CD AutoPlay feature enabled, the program will start 
automatically after you place the CD in the appropriate drive.

3.2 Installing CompuServe 3.0.2 for Windows NT 3.51:

1.  Insert CD-ROM in your drive.
2.  From the Program Manager, choose File and then Run.
3.  Type D:\RUN.EXE and then click OK.  (Replace D: with your drive letter if different.)
4.  If you do not have TCP/IP connectivity already installed and configured, follow the instructions 
under "Configuring the Windows NT 3.5.1 Dial-Up Remote Access Service (RAS Dialer)" in the 
next section.

4. Connectivity with CompuServe 3.0.2  

4.1 Dial-Up Networking in CompuServe 3.0.2 for Windows 95

The Windows 95 version of CompuServe 3.0.2 automatically utilizes Microsoft's Dial-Up
Networking capability.

This section will explain three scenarios:

1. A new member who has no pre-existing CompuServe software on their computer and is
installing CompuServe 3.0.2 for the first time (best method: Express Install)
2. An existing member who has previous CompuServe software on their machine and is installing 
CompuServe 3.0.2 for the first time into the same directory as their pre-existing CompuServe 
software (best method: Express Install)
3. A user who has a pre-existing Winsock, such as Trumpet or LAN connection, installed and is
installing CompuServe 3.0.2 for the first time (best method: Custom Install)

New Member Installing CompuServe 3.0.2 for the First Time

Express Installation:  When you choose Express installation, CompuServe 3.0.2 automatically 
sets up Microsoft's  Dial-Up Networking by default.  When installed through the Express method, 
CompuServe 3.0.2 also uses Microsoft's WSOCK32.DLL file.

After installing CompuServe 3.0.2 by using Express, your Connection Preferences will
be set for Dial-Up Networking in the Winsock Connection Type pop-up menu and CS3
Connection in the Connect Using pop-up menu.

Special Note for LAN users:  If you are using CompuServe 3.0.2 on a LAN that has TCP/IP



connectivity, the Connection window Dial-up Networking uses will continue to appear on your
screen.

To dismiss the connection window permanently:

1.  From within CompuServe 3.0.2, select Preferences from the Access menu and select the 
   General tab.
2.  Make sure the "Use External Internet Browser" checkbox is unmarked.
3.  Click the Define Browser Preferences button. This will bring up the Internet Properties 
    window.
4.  Click on the Connection tab and unmark the "Connect to the Internet as needed" checkbox.

LAN users will also have to go into the Connection Preferences and choose Default Winsock
from the Winsock Connection Type pop-up menu in order to connect with CompuServe 3.0.2.

Custom Installation:  Custom installation of CompuServe 3.0.2 gives you a choice for 
connectivity. You can either choose Install Dial-Up Networking or Use Existing Internet 
Connectivity if you don't want to use Dial-Up Networking.

If you select Install Dial-Up Networking, CompuServe 3.0.2 will use Dial-Up Networking to 
connect to CompuServe. Your Connection Preferences will be set for Dial-Up Networking in the 
Winsock Connection Type pop-up menu and CS3 Connection in the Connect Using pop-up 
menu - just like the Express installation.

If you select Use Existing Internet Connectivity, CompuServe 3.0.2 will not install Dial-Up
Networking and will instead use the first 32-bit Winsock it finds. The Connection Preferences will
be set for Default Winsock in the Winsock Connection Type pop-up menu and the Dial-Up
Networking box will be grayed out.

Installing CompuServe 3.0.2 into the same directory as WinCIM 2.0.1
When you upgrade from WinCIM 2.0.1 and install CompuServe 3.0.2 into the same
directory (usually /CSERVE), CompuServe 3.0.2 behaves exactly like it would if you had
installed CompuServe 3.0.2 for the first time.  Dial-Up Networking is installed by default when
Express Installation is used and you can avoid installing Dial-Up Networking by using the
Custom Installation and selecting Use Existing Internet Connectivity.

Installing 3.0.2 into the same directory as WinCIM 2.0.1 will not affect 2.0.1's connection process.

Installing CompuServe 3.0.2 with a Pre-Existing Winsock
If you have a pre-existing Winsock, you will need to install using the Custom method and should 
select Use Existing Internet Connectivity when asked. Otherwise, Microsoft's install of Dial-Up 
Networking may overwrite your pre-existing winsock.

Dial-Up Networking Phone Settings
For those of you who choose to install Dial-Up Networking, CompuServe 3.0.2 creates a Dial-Up 
Networking connection, named "CS3 Connection," which contains the phone number to be used 
to connect to the CompuServe network.

To modify your phone settings using Dial-Up Networking after installation, select Preferences 
from the Access pull-down menu, then, at the Connection page, enter the phone number to dial 
when connecting to CompuServe in the Phone # box.

4.2 Configuring the Windows NT 3.5.1 Dial-Up Remote Access Service (RAS Dialer):

Unless otherwise noted all settings or selections not specifically mentioned should be left at their 
default entries. 



Assuming you have not previously added RAS: 

1. In the Control Panel, double-click the Network icon. 
2. In the Network Settings window, click the Add Software button.
3. Select Remote Access Service from the pop-up list in the Network Software window. 
4. Provide a path to your NT distribution (disks, CD, or network location).
RAS will then install, and the Remote Access Program Group will appear. 
5. Then in the Add Port window, you'll see a list of all ports available to Windows NT RAS. 
Choose the port you will use. (RAS will offer to detect the modem connected to the port you 
selected. Choose OK to auto-detect the modem. NT will show the modem detected; select 
OK. Occasionally, NT may offer a choice of several modems to pick from; this will only occur 
if RAS cannot distinguish between 2 or more modems with similar characteristics.) 
6. In the Configure Port window, the detected modem will be highlighted. In the Port Usage 
section, choose "Dial out only." 

RAS is now installed. The next step is to configure it to dial CompuServe. 

Editing SWITCH.INF

1. Using a text editor such as Notepad or Edit, add the following section to the bottom of your 
SWITCH.INF file (normally located at \WINNT\system32\ras\switch.inf): 

===========================================

[CompuServe]
COMMAND=<cr>
OK=<match>"e:"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=+<cr>
OK=<match>"Host Name"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=CIS<cr>
OK=<match>"User ID:"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=#######,####/GO:PPPCONNECT<cr>
OK=<match>":"
ERROR_NO_CARRIER=<match>"NO CARRIER"
LOOP=<ignore>
COMMAND=PASSWORD<cr>
CONNECT=<ignore>

2. Be sure to put in your actual CompuServe User ID [123456,1234] and CompuServe password 
[XXXX0XXXXX] in place of ######,#### and PASSWORD. 
3. Save the file. 

Editing the RAS phonebook 

1. Go to the Remote Access Program Group and double-click the Remote Access icon. In the 
resulting window, click Add. 



You will be presented with an Add Phone Book Entry window.

2. Name the new entry whatever you want (probably "CompuServe" or something similar). 
3. Enter the phone number of your local CompuServe dial-up site, plus any modifiers 
needed (such as 9 to reach an outside line or *70 to disable call waiting). 
4. Leave the Description field blank (optional). 
5. Make sure that "Authenticate using current name and password" is not marked. 
6. Select the correct COM port for your modem. 
7. Click the Modem button. Choose the correct port speed. Mark "Enable hardware flow control,"
"Enable modem error control," and "Enable modem compression." Do not mark "Enter modem 
commands manually." Click OK. 
8. Select the Network option. Choose PPP, and mark "TCP/IP" and "Request LCP extension". 
9. Click the "TCP/IP Settings" button. Choose "Server Assigned IP address" and "Use specific
name server addresses." Then enter in DNS 149.174.211.5 and DNS Backup 149.174.213.5. 
Mark both "Use VJ header compression" and "Use default gateway on remote host." 
10. Select the Security option. Make sure "Accept any authentication including clear text" is 
selected. In the "Terminal or Script" section, select CompuServe in the pop-up menu for 
"After Dialing." (The CompuServe option will only be available if you made the necessary 
changes to SWITCH.INF) 
11. Click OK. 

Return to the Remote Access window. You will now see a new setting for CompuServe. Simply 
select Dial to connect to CompuServe.

4.3 Configuring the Windows NT 4.0 Dial-Up Remote Access Service (RAS Dialer)

Unless otherwise noted all settings or selections not specifically mentioned should be left at their 
default entries. 

1. Go to Start|Settings|Control Panel and double-click on the Network icon. Then choose the    
Services tab. If Remote Access Service is not on the list, add it by choosing the Add button. 

Note: You must have Administrator privileges to install RAS. TCP/IP and other necessary 
components should be installed along with RAS. If they are not, you do not have Administrator 
privileges and should consult your manual or VAR.

2. Go to Start|Programs|Accessories|Dial-up Networking and choose the New button. 
3. In the New Phonebook Entry Wizard window enter CompuServe for the name and choose 
Next. 
4. In the Server window mark the "I am calling the Internet" and "Send my password as plain text 
if that's the only way to connect" boxes and choose Next. 
5. In the Phone Number window enter your local CompuServe Access phone number and    
choose Next. Enter any Alternate numbers by choosing Alternate. 
6. In the New Phonebook Entry Wizard window choose Finish.

Note: If this is the first time you have made a Dial-Up Networking entry you will have a few more 
screens, just click on the Next button for each one. 

7. On the Dial-up Networking window choose More, then select Edit entry and modem properties.
You can also choose Create shortcut to entry on this menu to place a shortcut icon on your 
desktop. 
8. The Edit Phonebook Entry, Basic tab lists basic information about the Entry. You can also 
Select the Alternates button to enter alternate phone numbers to dial. Selecting the Configure 
button will allow you to set some modem properties.
9. After clicking the Alternates button, you can enter in additional phone numbers to dial.
10. After clicking the Configure button, you can edit some of the modem properties including error



correction, flow control, data compression, port speed and the modem speaker.
11. Click on the Server tab and mark TCP/IP, unmark IPX/SPX and NetBEUI. Also mark       
Software compression and PPP LCP extensions.
12. On the Server tab, select the TCP/IP Settings button. In the PPP TCP/IP Settings window, set 
IP Address for "Server assigned." Then enter 149.174.211.5 in the Primary DNS field and 
149.174.213.5 in the Secondary DNS field. Leave Wins all zeros, mark both boxes at the bottom 
and then click OK. 
13. Click on the Script tab and, from the pop-up list, choose cis.scp.
14. Select the Before Dialing button and make sure that "None" is marked and click OK.
15. Select the Security tab and mark "Use any authentication including clear text" or "Accept only 
encrypted authentication." The Unsave password button will unsave your password so that you 
can re-enter your password if necessary (see step 22).
16. Settings on the X.25 tab should be blank.  Then click OK.
17. From the More button menu select User Preferences.
18. On the Dialing tab put a check in the box next to the Location listed in the Auto-dial by 
location box. If you set the Idle seconds before hangup to 10 seconds, Dial-up Networking will 
disconnect the connection if left idle. You can also set the number of retries and whether or not 
Dial-Up Networking redials if the connection is lost.
19. On the Callback tab, mark "No, skip callback." 
20. On the Appearance tab there are various options that can be set. All of the options should be 
checked.
21. On the Phonebook tab, mark "The System Phonebook."
22. Select Dial in the Dial-up Networking window. The first time you connect you will be asked to 
enter your CompuServe User ID number (with the comma) in the User Name field and your 
Password in the Password field. Leave the Domain field empty and check Save password if you 
want to save the password. If you need to change your password you would need to click the 
Unsave password button on the Security tab (step 15).
23. Click on OK to dial. Do not disturb the After Dial Terminal window but watch the log in and if 
you get "?? LOGINE - Invalid entry - try again" after the Password: prompt, your password is 
incorrect. 
24. In the SysTray on the Taskbar, there will be the Dial-up Network icon. If you right click on this 
icon you can hang up the connection or select Open Dial-up Monitor to get information about your
connection, including the DCE connection speed (bps) and your IP address (Details button). 
25. In CompuServe 3.0.2, from the Access pull-down menu, select Preferences. Under the 
Connection type the Winsock should be set for Default WINSOCK.

4.4 Signup or Startup?

Based on whether it finds a CIS.INI file, CompuServe 3.0.2 can usually determine your 
membership status and will prompt you to sign up a new account or set up the software (if you 
are an existing member).  If a CIS.INI file is not detected, you will see the Welcome window, 
where you can either sign up a new account or set up the software.  New members should 
always select Signup from the Welcome window. However, if you already have a CompuServe 
account and are running from a directory where CIS.INI cannot be found, you will need to select 
Setup.

Current members should note that CompuServe 3.0.2 does not include a Winsock checkbox in 
the Connection settings, as WinCIM 2.0.1 does.  All CompuServe 3.0.2 connections require PPP 
and use Winsock. This feature enables us to provide easy Internet access and new built-in multi-
tasking support.
 
5. Upgrading Your Filing Cabinet

The Filing Cabinet in CompuServe 3.0.2 stores Mail messages, Forum messages, news articles 
(stories), and other types of text articles that you want to review or use later.  Simply click the File 



It button in the message or article window, and then select or create the folder in which you want 
to store it.

To access the Filing Cabinet, click the My Information side button (on the Home Desktop), and 
then click the Filing Cabinet top tab.  Or, select the Filing Cabinet button located on CompuServe 
3.0.2's toolbar.

5.1 Filing Cabinet Conversion

The Filing Cabinet in CompuServe 3.0.2 uses a different format than the Filing Cabinets in 
previous versions of CompuServe software.  Items stored in previous versions of the Filing 
Cabinet will need to be converted before you can view them in CompuServe 3.0.2.  Items saved 
in CompuServe 3.0.2's Filing Cabinet cannot be viewed with previous versions of CompuServe 
software.

5.2 Filing Cabinet Conversion Utility
This utility converts the contents of a Filing Cabinet created with versions of WinCIM, DOSCIM, 
and CSNav to the new CompuServe 3.0.2 format.  If you install CompuServe 3.0.2 into the same 
CompuServe directory as your other products, the Filing Cabinet Conversion Utility runs 
automatically the first time you install CompuServe 3.0.2, but can be run any time.

To convert the contents of the Filing Cabinet after the initial installation of CompuServe 3.0.2: 

1. Start the Filing Cabinet Conversion Utility (located in the CompuServe program group).
2. Type the source and destination directory paths in the Convert Filing Cabinet window.
3. Click Begin.

5.3 Filing Cabinet Utility
This utility enables you to perform backup and general maintenance on your Filing Cabinet.  In 
addition to backup, you can use it to recover wasted space, repair damaged records, and merge 
information from multiple Filing Cabinets.  Features include:

- Backup
- Restore
- Compress
- Repair
- Statistics

    - Preferences

To back up (copy) your Filing Cabinet:

1. Start the Filing Cabinet Backup Utility (located in the CompuServe program group).
2. Choose the Copy to file command from the File menu.

A window will be displayed where you can specify the current Filing Cabinet directory and the 
name of the file (backup file) you want to create.

General maintenance tasks can be performed using appropriate commands on the Filing Cabinet 
pull-down menu.

6.  Setting Up Netscape Navigator as your External Web Browser

These instructions are correct for Netscape Navigator 2.0.2 and higher.



In CompuServe 3.0.2:

1.  In CompuServe 3.0.2, select Preferences from the Access menu.
2.  Click on the General top tab.
3.  Click the Select button.
4.  Find NETSCAPE.EXE and double-click it.
5.  On the General top tab, mark "Use external browser" and click OK.

In Netscape Navigator:

1.  In Netscape Navigator, choose General Preferences from the Options menu.
2.  Click on the Helpers top tab.
3.  Click the Create New Type button.
4.  In the Mime Type field, enter "application" (no quotes).
5.  In the Mime sub-type field, enter "x-gocserve" (no quotes).
6.  Click OK.
7.  In the File Extension field on the Helper tab, enter "go" (no quotes).
8.  Mark the "Launch the application" option.
9.  Click the Browse button and double-click GOCSERVE.EXE. Then click OK.

7. Feature Highlights of CompuServe 3.0.2

A New Multimedia Look

CompuServe 3.0.2 has a redesigned, multimedia interface that is graphically rich and easy to 
navigate.  It also allows automatic viewing of files such as charts, photos, and other multimedia 
files.

New Web Browser for Windows 95 and Windows NT 4.0:
Microsoft Internet Explorer 3.02

We also offer complete, easy access to the Internet through our integrated Web browser from 
Microsoft, Internet Explorer 3.02.  Microsoft Internet Explorer 3.02 contains all known security 
fixes.

CompuServe 3.0.2 contains the latest version of Internet Explorer 3.02.  If you have this (or an 
older) version installed on your compter, then CompuServe 3.0.2 will install the newest version to 
ensure that you are running the latest software and that your current installation is complete.  If 
you currently have a build newer than 1215 installed, CompuServe 3.0.2 will use your existing 
version.

For Windows NT 3.51 users, we offer Internet access with Microsoft Internet Explorer 2.1.

Multi-Tasking

CompuServe 3.0.2 has multi-tasking capability, which saves you time by allowing you to perform 
multiple tasks simultaneously.  Use the To-Do List to manage retrieval of messages and files in 
the 'background,' while you are doing other online activities, such as reading news articles or 
browsing a Forum area in the 'foreground.'

Personalizable, Customizable Features

Time-saving, organizational tools in CompuServe 3.0.2 let you track where you've been by 
checking your list of recently visited places, save frequently visited places in your Favorite Places 
list, or customize your toolbar for easy access to frequently-used tasks.



Free Software

Look in your \BONUS_W directory on your CD-ROM drive (D: in most cases) for free bonus 
software.  Included on your CD are titles such as WorldsAway, Air Warrior II, Adobe Acrobat, and 
more.  Just install the software you're interested in and enjoy - compliments of CompuServe.

8. Support Information

8.1 Help System

- Learn About Help:  Most main desktops have a Learn About side button, which you can click to 
find out how to accomplish your tasks using the desktop features.  If you're a new member, new 
to CompuServe 3.0.2, or not a frequent user, Learn About Help is a good place to begin.

- Help Menu:  To learn how to use the Help system, choose "How to Use Help" from the Help 
Menu.  Choose "Contents" from the Help menu to view the Help system's table of contents.  

8.2 Online Resources

Once you have installed CompuServe 3.0.2 and become a member, you can connect to 
CompuServe for a wealth of information, software, and services.  Simply click the Assistance top 
tab on the Home Desktop, then click Member Services to view a menu of available resources for 
help and assistance.  For information and support on CompuServe 3.0.2 and related software,  
type GO CSWIN to go directly to the CompuServe 3.0.2 Support Area.

9. Recovering Hard Disk Space

If you need additional space on your hard drive, here are some suggestions:

- Deleting old WinCIM Signup files will recover 600K.  To do so, delete C:\CSERVE\
WINSIGN.

- Deleting Mosaic cache files will recover up to 5 Mb (if you used the default cache size).  
To do so, delete C:\CSERVE\MOSAIC\CACHE.

- Deleting the Mosaic software will free up to to 1.9 Mb.  However, be aware that this will 
also remove any hotlists you have in Mosaic.  To do so, delete C:\CSERVE\MOSAIC.

- If you no longer need to use WinCIM, you can recover approximately 2 Mb by deleting   
C:\CSERVE\WINCIM.

Caution:  Be sure not to delete the contents of your C:\CSERVE directory when you are 
deleting the sub-directories.


